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Note for PanCanvas 2 Demo users:  Your demo version is fully functional, except that you cannot generate the final animation (i.e., you cannot render frames).
INTRODUCTION	
Welcome to PanCanvas 2 for ImageFX!  After the success of the first PanCanvas, we took your suggestions and made it even better.  PanCanvas 2 sports a new interface that is easier to navigate, has increased speed, supports FlyerClips, and more.
PanCanvas 2 is an extension to ImageFX, transforming your Amiga into a powerful motion control engine.  Motion Control allows you to create animation from a still image by panning smoothly over it.  Documentaries often use Motion Control to create dramatic pans and zooms on old documents or photographs—like an old family picture.  PanCanvas 2's virtual camera can move smoothly over a straight line or a curve, can accelerate and decelerate, "hold" on the beginning and end frames.  PanCanvas 2 is an easy tool to create extremely sophisticated motion effects, the results of which are quite stunning on an audience.
If you were a PanCanvas 1 user, you will appreciate the enhanced setup screen, greater output flexibility, and the considerable speed improvements in the panning render engine.
NOTICE	
PanCanvas 2 is registered software.  You have purchased a commercial license for PanCanvas 2 through Legacy Maker, Inc.  On your disk is a registration number which identifies you as the owner of PanCanvas 2.  You are entitled to use PanCanvas 2 on a single Amiga.  Fraudulent use of this software is a violation of copyright law.  Now more than ever, it is important that you spread the word and not the disk!
REQUIREMENTS	
PanCanvas 2 requires an Amiga with ImageFX 2.6, 3.3, or 4.1a.  If you are using ImageFX 2.x or 3.x, contact Nova Design or visit their website www.novadesign.com for the latest upgrade to 2.6 or 3.3, respectively.  
For ImageFX 4 users, we have included a special copy of ImageFX 4.1a, which provides compatibility with PanCanvas 2.  Simply dearchive the “ImageFX41_Patch.lha” file you’ll find on the PanCanvas 2 floppy disk to RAM: or another convenient location.  The uncompressed file is simply called “ImageFX.”  Copy this file into your ImageFX directory over the old version.
If you do not have a way to dearchive files, you can get the LHA archiving utility from Aminet at http://ftp.wustl.edu/~aminet/, or contact your Amiga dealer.
You can now use PanCanvas 2 with any model of Amiga—AGA, ECS, or any graphics card that ImageFX supports.  You will need to run ImageFX on at least a 640x400 screen, but the bigger, the better.  PanCanvas 2 also works best with 2 MB of Chip RAM (or at least a 2 MB video card), and at least 16 MB of fast RAM.
INSTALLATION	
If you are already using an earlier version of PanCanvas, remove it (including "LaunchPanCanvas2.ifx" from your Rexx directory) before installing PanCanvas 2.
Insert the PanCanvas 2 disk, double-click on the disk when it appears on your Workbench screen, then double-click on the "Install" icon.  The install routine seeks out ImageFX and installs the PanCanvas 2 files appropriate to that version.  Remember, you need ImageFX 2.6, 3.3, or 4.1a (see “requirements”).
NOTE:  Some users keep several versions of ImageFX installed on their Amiga.  The PanCanvas 2 installer seeks out the lowest version first.  If you have both ImageFX 2.6 and ImageFX 4.1 installed on your computer, the floppy will install PanCanvas into the ImageFX 2.6 directory.  If you wanted to install PanCanvas to ImageFX 4.1 in the above scenario, you will have to temporarily disable the assigns to ImageFX 2.6.  If you do not know how to do this, simply check out our website, www.legacymakerinc.com, for more information.
When you first installed ImageFX, the program set up certain directory assignments automatically.  As long as you have not made any modifications to these assigns, the installation will go smoothly. 
TROUBLESHOOTING:  If the installer informs you that "Install could not locate ImageFX", then you have most likely changed one of the standard ImageFX assignments:  IMAGEFX:, IMAGEFX3:, or IMAGEFX4:.
TROUBLESHOOTING:  If you are presented with a requester asking you to insert volume IMAGEFX: and/or IMAGEFX3: then you most likely have a system patch installed on your Amiga that traps unknown assigns.  Just click on the CANCEL gadget in those requesters and the installer should find work its way to the version of ImageFX that you are using.
PANNING	
The key to an attractive PanCanvas animation is a large source image—one with resolution significantly greater than the target animation will have.  Photo and film resolutions work best.  (Remember the television documentary example:  the focus is on just a small area of the photograph, and it is filling your entire screen!)  If you try to pan around an image that is too small, you will see big pixels in your finished animation.  For example, you cannot start with a video frame, and try to make an animation that is video size—there is no room to pan around the screen without zooming in too far—causing pixels to look very big.  In fact, PanCanvas will tell you your output size is too small (see the enclosed FAQ for a trick to make this kind of animation possible).
If you are using a digital source, PhotoCD's are a good place to start, as they typically store both small and very large resolutions of images.  If you are scanning a photo in hopes of panning it for video, we have found our most dramatic results come from scanning the image so that it is at least four times the size of your output image (consider 200 dpi [dots per inch] a bare minimum).
Getting Started…
In ImageFX, load up the image that you wish to make an animation from.  Then launch PanCanvas 2 by pressing the "AREXX" button in ImageFX, and double clicking on "PanCanvas.ifx".  In a few seconds, you will see a window that we like to call...
THE “SET OPTIONS” WINDOW
While creating PanCanvas 2, our priority was to keep it easy to use.  You will find all the options that you need in one convenient screen.  From here, you determine the save format, the animation length, choose to render frames or fields, even use new features like "Pre Roll," "Post Roll," and the ability to execute macros!
The interface is arranged in seven sections from top to bottom.  The topmost section controls the PanCanvas 2 preview window settings:
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ImageFX Screen:  Designates where PanCanvas 2 will open its preview window.  This will default to “Workbench”.  If you do not have a graphics card and are very short on chip RAM (for instance, if you are currently running Toaster/Flyer software), you can leave it on "Workbench" (no quotes).   However if you are using a graphics card or opening ImageFX on its own screen, then change this to “ImageFX” (no quotes). 
Temp Path:  Points to the directory where PanCanvas 2 will place temporary files.  Leaving the setting on RAM: gives you the best performance, but if your computer is short on spare memory you may need to use a real hard drive directory path.  
Preview:  Controls the color depth of PanCanvas 2's preview screen.  This does NOT affect the color depth of PanCanvas 2's output.  128 colors is the maximum, and is only compatible with AGA or graphics card-equipped Amigas.  If you have an ECS Amiga, set this value to 16.  You may also want to use fewer colors to get faster preview performance, although a low-color preview may not be very attractive.  Be sure not to set this value higher than the maximum number of colors available on the screen you open it on.
Grid X/Y:  The PanCanvas 2 preview screen offers a "snap to grid" alignment tool to let you align the panning marquees to a grid.  The X and Y values define the size, in pixels, of the grid.
Once you specify the above four parameters, PanCanvas 2 will "remember" them next time you run the program, but you are always free to change any of these options at each session of PanCanvas 2.
• • • • •
The next section controls the size of the output frame:  file_2.png
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In the popup list, you can choose from three popular sizes of video frame, or you can choose "custom" then enter your own values for width and height in the W: and H: boxes.  If you change "Use" to "Save,” PanCanvas 2 will add your custom dimensions to the Frame Size drop-down box for future quick access.
• • • • •
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In the third section you define the number of frames, and thereby the length of the animation you wish to create in PanCanvas 2.
# Frames:  Here you define the total number of frames you want PanCanvas 2 to output.  More frames make for smoother motion and/or a longer animation, but also take longer to render.  Do a little arithmetic:  a 1-second videotape-ready animation requires 30 frames.
Render Range:  PanCanvas 2 is VERY SMART as you'll come to realize here. This option is a tremendous time saver if your Amiga crashes, there's a power failure, or something else happens to cause PanCanvas 2 to abort rendering.  By changing these values you can get PanCanvas 2 to generate a limited range of frames from the entire sequence.  Let's say you're rendering a 100 frame sequence, but your Amiga crashes part way through.  You reboot the computer and see that the last frame that got saved was #50.  You restart PanCanvas 2, but realize that you forgot to save your settings and the pan motion.  No need to worry!  Before it begins rendering a sequence, PanCanvas 2 saves your current Motion and Ease configurations as LAST_USED files.  It also remembers all your Set Options settings automatically.  After reloading the LAST_USED configuration files, set the Render Range as 51 to 100 and start rendering.  PanCanvas 2 will start rendering with frame #51.  WOW!  Note that, if you are outputting to an animation file (FlyerClip or Jstream), it may be difficult to tell what frame PanCanvas 2 last saved. In this case, you may have to load the animation into ImageFX or some other animation software to determine what the last frame saved was.
Pre Roll/Post Roll:  For aesthetic reasons, you may want the PanCanvas 2 camera to "freeze" (display a static image with the camera at rest) at the beginning and/or ending of your animation.  Although this effect is relatively easy to create manually using a little creative file copying, PanCanvas 2 can now create this pre/post roll automatically. 
REMEMBER:  The pre/post roll frames count in the total number of frames you defined in the "# Frames" section.  So if you have a 90 frame animation with a 5 frame pre-roll and a 5 frame post-roll, the camera will only be in motion for 80 frames.
• • • • •
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The fourth section consists solely of the Render Method option.  PanCanvas 2 will render either video fields, or complete frames, at your discretion.  Video fields may be required by some video editing packages.  If you are creating an MPEG or Amiga ANIM animation, you will probably want to stick with frames.
• • • • •
file_8.png


file_9.wmf


The fifth section allows you to add two ImageFX macros to the PanCanvas 2 render process.  In the past, if you wanted to apply a special effect (such as a blur, or color balance) to your PanCanvas 2 output, you would have needed to use AutoFX or IMP on the finished frames.  Now, you can add up to two macros to the PanCanvas 2 clipping process, saving you time.
• • • • •
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The sixth section controls the type and destination of PanCanvas 2's output.
Save Path:  Designate the destination directory for PanCanvas 2 frames.
File Name:  All of PanCanvas 2's output frames start with the same core filename followed by their frame number.  Enter the root filename here (such as "streetpan").  Do not use wildcards.
Save Type:  Select the output file format from the first drop-down box.
PanCanvas 2 can generate two video clip formats:  FlyerClip (NewTek Video Flyer) and Jstream (Broadcaster Elite).  NOTE:  You cannot create FlyerClips unless you have Video Toaster Flyer installed.  Jstream animations can be created only if you have Jstream Clone files installed on your system.  These are not limitations of PanCanvas 2, they are requirements of ImageFX's savers.  You can also generate IFF, JPEG, or TIFF frames which you can use in many Amiga and non-Amiga applications.  If necessary these frames can be converted using ImageFX into Amiga ANIM format, MPEG, GIF Anims, or any of the other formats that ImageFX supports.
If you are saving as FlyerClip or Jstream, you may also choose between Overwrite (which, if the File Name you have indicated already exists, will overwrite that file with the new PanCanvas images) or Append (which will add the new PanCanvas frames to an already existing file).
Save As: Choose whether PanCanvas 2 generates fields or frames. 
First Frame:  When PanCanvas 2 saves frames it numbers them starting with the number you indicate here, then incrementing by 1 for each frame rendered.  Normally, you want this value to be set to 1 (so a 90 frame animation would create frame files numbered from 1 to 90).  But if you are integrating PanCanvas 2's output into a longer animation, you may want to start numbering at a higher value.  For example, you would change this to 101 if you had already generated a series of 100 images and wanted the next batch to be numbered 101, 102, 103, etc. 
• • • • •
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The final section contains image format-specific settings.  None of these settings apply if you choose to save frames in IFF format.
FlyerClip:  For Toaster Flyer users. We intended for this setting to let you select the compression used when creating your PanCanvas 2 FlyerClip.  Unfortunately, the Flyer will always use the last FlyerClip compression setting you recorded with in the Flyer software.  This is a well-known bug in the Flyer.  If the Flyer software is ever corrected, this setting should work as we intended.
JPG %:  This is the quality setting for JPEG output frames.  The higher the percentage value, the higher quality the JPEG frame.  Lower values generate smaller files, at the cost of poor image quality.
Jstream Clone:  To create animations in the Jstream format, you must have Jstream Clone files installed on your system.  Use this option to tell PanCavas 2 which Clone file to use.  Clone files are Jstreams' method of setting image quality.
TIFF:  Select from normal or LZW Compression.  TIFF files can be very large, so LZW lossless compression will save disk space.  LZW compression slows down the saving process, though.
Use the Save button at the bottom of the screen to save these settings for future use.  The Load button allows you to recall a previous configuration.
When you are ready to create your pan, click Okay to launch PanCanvas 2! (Note:  If you need to change the options you have set, you can re-access the Set Options window under the “Options” pull-down menu.)
GENERATING A PAN	
After a brief wait, the PanCanvas 2 preview window will appear.  You will see a scaled version of your image, and two overlapping windows, called "marquees."  One is labeled "Start," the other "End."  The first image (and any pre-roll) in your animation will be clipped from the Start marquee, and the last image (and any post-roll) will be clipped from the End marquee.
By clicking and dragging the marquees, you can plan the scene you are about to create.  (NOTE:  PanCanvas 2 gives priority to the start frame marquee if you click where they overlap.)
To create a zoom effect, click on the small handle in the lower-right corner of the marquee and drag the marquee larger or smaller, as desired.  A larger End marquee creates a zoom-out effect, a smaller End marquee indicates a zoom-in effect.  If your zoom-in is too severe, you may experience unwanted pixellation.  A solution to this problem is to enlarge and then blur the original image (you may also want to experiment with “sharpen” tools after this process; the computer can often add detail to the picture).  Then create your animation from this bigger image.  It will look much better this way.
Curved Animation Paths
In the Options menu, you can choose to create an animation with a curved path.  The program defaults to a straight-line animation path, but by choosing “Spline” the marquees gain handles that let you define a curved path.  Once you have selected Spline mode, you cannot move the marquees—switch back to Linear mode if you have to make position changes, then return to Spline mode before you render the animation.
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EASE
PanCanvas 2 also gives you a great deal of control over the speed of the virtual camera over your picture.  By using the “Ease” function  you control the rate of the camera’s acceleration and deceleration at its beginning and end positions.  To access the Ease control panel above, select “Ease” from the Options pull-down menu.  
The Ease graph represents how much the virtual camera speeds up or slows down during the animation.  By default the line is straight, making the animation go at a constant speed—it does not speed up or slow down.  But when the graph is curved, the animation will accelerate or decelerate.  
With the graph above, the animation will start out moving slowly, then speed up gradually, and finally slow to a stop.  This is referred to as an “ease-out” at the beginning of the animation, and an “ease-in” to the end position.
On the graph, the horizontal axis (X-axis) represents frame number, while the vertical axis (Y-axis) represents the distance that the marquee travels along the path you created.  So where the ease graph is nearly horizontal (flat), the animation is moving very slowly.  When the ease graph is nearly vertical (steep), the animation is moving very quickly.
You can change the shape of the graph with the X and Y buttons at the corners of the graph, which set the ease values.  The numbers are set to increment by 10 units.  This gives you a lot of flexibility in animation speeds.
By loading other settings via the “Load” and “Save” buttons, you can see other graphs and their results.  You can also load the settings from your last session by selecting “LAST_USED”.
“Reset” reverts the graph back to a straight line.  “X< >Y” flips the X and Y values, while “In< >Out” swaps the In and Out values on the graph.  
Once you are satisfied with your settings, select the upper left 'close-gadget'
of the window to exit. This will automatically store your settings in a config file that PanCanvas 2 will read when it begins to generate the animation.
RENDERING	
To start the render process, right-click the mouse and select Create Pan from the Project menu.  A requester will appear and summarize the animation you have defined.  To start the process, click Okay.  The Preview option will simulate the path your animation will take.  (Warning:  The preview option is rather time consuming!)  If you want to make more adjustments, click Cancel.
Take note of the status bar at the top of the screen (actually a small window title bar that you can click and drag wherever you find it convenient).  The status bar will update you on PanCanvas 2's activities, such as indicating what frame is currently being rendered.
FINISHING	
If you chose to create a FlyerClip or Jstream animation, you are ready to integrate the results into your video project.  If you used IFF, TIFF, or JPEG output, you now have a set of 24-bit images, cropped from your high-resolution source.  These can now be assembled into the animation format of your choice (such as ANIM, ANIM7, or MPEG) using ImageFX's vast capabilities, or the third-party animation software of your choice.
FINAL WORDS	
PanCanvas 2 is a powerful update to one of the most innovative plug-ins ever devised for ImageFX.  By familiarizing yourself with its operation you will be able to create fascinating animations from what might have seemed dull or lifeless stills.  We hope you enjoy PanCanvas 2!
TUTORIAL VIDEOS	
A PanCanvas tutorial video segment is available on the latest installment of Legacy Maker’s Catalyzer™ series of tutorial videos for ImageFX.  The tutorial shows you step-by-step how to create an animation from your still image.  
The tape also features tutorials teaching you how to use Layers in ImageFX 4, how to set up and use color printers and scanners on your Amiga, how to use FXforge, and more.  The tape includes 3 floppy disks full of demonstration and support materials, like ImageFX ready FXforge filters, and the Time Machine multi-layer effects plug-in for ImageFX.
You can order the Catalyzer 3 Tutorial Video for ImageFX directly from Legacy Maker, Inc. or from select Amiga dealers.  Catalyzer volumes 1 and 2 are also full of tips and tricks for ImageFX.  Get more info online at www.LegacyMakerinc.com
Order Legacy Maker products direct:
Legacy Maker, Inc.
PO Box 60711
Chicago, IL 60660
(773)465-5158
TECHNICAL SUPPORT	
Support for PanCanvas is available through e-mail at: pancanvas@LegacyMakerInc.com 
Telephone support for PanCanvas is not available at this time.
Also visit our website for guidance:
www.LegacyMakerinc.com
Documentation © 2001 Legacy Maker, Inc.
PanCanvas 2 © 2000–2001 dhomas trenn
PanCanvas 1 © 1996–1999 Ola Olsson
Notice for PanCanvas 2 owners: This software is licensed to the buyer for the use of one copy of the software on a single computer at a time. You, the software user, acknowledge that the software may not satisfy all your requirements or be free from defects. Legacy Maker, Inc. warrants that the media on which the software is recorded to be free from defects in materials and workmanship under normal use for 90 days from purchase, but the software and accompanying written materials are licensed “as is.” All implied warranties and conditions (including any implied warranty of merchantability or fitness for a particular purpose) are disclaimed as to the software and written materials and limited to 90 days as to the media. Your exclusive remedy for breach of warranty will be the replacement of the media or refund of the purchase price. In no event will Legacy Maker, Inc. or any of its developers, directors, officers, employees, or affiliates; Ola Olsson; or Dhomas Trenn be liable for any consequential or indirect damages (including damages for loss of business profits, business interruption, loss of business information, and the like), whether foreseeable or unforeseeable, arising out of the use or inability to use the software or accompanying written materials, regardless of the basis of the claim and even if Legacy Maker, Inc. or an authorized Legacy Maker, Inc. representative has been advised of the possibility of such damages. Because some jurisdictions do not allow the exclusion or limitation of implied warranties or liability for consequential or incidental damages, some of the above limitations may not apply to you.


